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In te r v i e w :
H an s v a n d e n H u r k

Mostly fans of funky jazz should

Furthermore I’m working with “Seven Ele-

How did it develop, changing from

know the Dutchman Hans van den

ven” on our upcoming CD, Seven Eleven

acoustic to electronic drums?

Hurk, because he and his band

is my “hobby” band in which we play or

Seven Eleven are playing on events

When I was first contacted by the Proms

own repertoire of Funk music, mixed with

like North Sea Jazz. Since this year

management this autumn, I was told that

hiphop and jazz. (See www.seveneleven.nl)

I had to use electronic drums, mainly to

the Yamaha endorser is hitting on

avoid mixing problems with the orches-

his round pads for the „Night of

The upcoming album “Back To The Source”

the Proms“ tour - but this time the

will feature Louis Johnson (Michael Jack-

pads are electronic and trigger a

son/Brothers Johnson) amongst others.

I contacted Yamaha for the DTX kit, being a

DTX950k.

This is a fun project in which I can groove

Yamaha acoustic drums endorser.

all night long.
Hi Hans, tell us about your recent
activities: What are you up to at the
moment?
Well, at this moment I’m on tour with
“Night of the Proms” (www.notp.com). We
did shows in Belgium and the Netherlands,
and now we tour Germany and Luxemburg.
It’s an amazing show in which we play with
a rock band and a complete symphonic

tra or big Plexiglas shields around the kit
which would affect the light show. Therefore

Despite the samples sounding great right

Besides all this I work at the Rock Acade-

away, it took a few moments getting used

my, which is a conservatory for pop music

to the playability. An electronic drum kit

at the Fontys University of Applied Sciences.

responds different from an acoustic one no

I teach drums there, and I’m in the management.
Can you explain us your set-up for the
Night of the Proms tour?

matter which brand or model. Tweaking the
sensitivity/velocity of the pads made a big
difference and as I started playing with it.
I also edited the samples and added some
new ones. This has made me feel comfortable and now I’m very happy with it, and
so is our front of house mixer!

orchestra. We only play in large venues with

Yeah, I use the Yamaha DTX950k set, with a

+10.000 people capacity etc.

slightly changed HEXRACK set-up. I use one

In this tour I have the honor to play with

tom pad on the left of my hihat as a second

Seal, Chic, James Blunt, John Miles, Alison

snare pad. I use acoustic Zildjian cymbals

Moyet, Angie Stone, Mick Hucknall and in

with the kit. This feels like the best of both

Probably the best thing about it is that I can

Germany Stanfour as well!

worlds set-up!

use the sound of several drum kits during

EUROPE.YAMAHA.COM
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one show. When we do Angie Stone I use

tight. Using this set up took care of that! It’s

loaded them into the DTX module and eve-

a contemporary kit with a tight 20” kick

a great band to play in, so I’m really happy

rything worked out fine!

and high pitched snare and toms. With

everything worked out.
Did you make any modifications to the

James Blunt I use a tuned down (!) 24” kick
and tuned down snare for a large vintage

Which Drummers and which sounds have

kits you used for “Night of the proms”?

sound. So with every artist it’s possible to

influenced you most?

Yes. I mainly use the internal Voices, but

Wow, it’s difficult, because I’m influenced

edited most of them. Tuning, decay, amount

switch from one set to another by only pressing a button.
The second huge advantage is that the
sound is very controlled, we don’t have
problems with microphone placing or
acoustics, it just sounds great every night!
Further advantage is that the acoustic

by good music in the first place. But to
name some drummers I think play fantastic: Steve Gadd, Steve Jordan, Questlove,
Adam Deitch, Keith Carlock, Vinnie Colaiuta, Clyde Stubblefield, Peter Erskine, Elvin
Jones, David Garibaldi…

sound level of the drums on stage is
reduced so there’s no problem amplifying

Which drum kits from the DTX900 do you

the clarinets and oboes without me having

use?

to play in a Plexiglas cage.

I use different samples from many kits.

of snares „ringing“, everything. I think this
is possible because the source samples are
so strong they keep working if you tweak
them... I also edited the triggering, velocity
curves and sensitivity to make it feel more
like my acoustic kit as much as possible and
adjust it to the surrounding of our band.
Have there been any “Spinal Tap”moments on this tour? If so, please tell
us about it.
Well, unfortunately for good stories, this

How are the reactions from other
Do you utilize your own samples in the

production exists more than 25 years now,

DTX?

so the whole production, lights, sound,

were some problems with latency, dynamic

Yes, but only one kick and one snare.

rigging, catering, transport, everything is

playing and timing with the click track. As

These are the samples one of the artists

extremely

everybody uses in-ear monitoring it’s very

used on the latest cd, they’ve sent them to

important that everything sounds and feels

me as .wav and .aiff file. I took a USB stick,

musicians you share the stage with?
They are enthusiastic! On the last tour there

professional,

so

technically

nothing much happened yet.
It only gets exciting when an artist doesn’t

EUROPE.YAMAHA.COM
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realize that we’re on click track, with per-

I‘m looking forward to it not to say the least

cussion loops and video in sync, and an

because then I can take my new Yamaha

orchestra that reads music, guided only by

PHX drums for a spin!

a conductor. If you’d like to add eight extra
bars for audience participation, or make a
small mistake leaving out a chorus, you’re
going to feel being run over by a train, because we don’t stop for anything...
It’s best not to state here which artists tried
this, but it happened more than once...
Tell us about your plans for 2012!
Well, at the end of 2012 we’ll be touring
with Night of the Proms again! Then we
add, besides Belgium, Holland, Luxemburg
and Germany, some Scandinavian cities to
the tour list.
In summer I’ll be doing festivals with Dutch
band Het Goede Doel.
But 2012 will start (besides some live jobs
as a session player) with the release of the
Seven Eleven album, and hopefully a club
tour and some festivals to promote it!
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Carl Spitzweg „The Bookworm“ PublicDomain

Total Lib r a r i a n f o r
MOTI X / M OX / S - S e r i e s

John Melas

The John Melas Total Librarian for
XS series is a complete librarian
solution for the Yamaha MOTIF
XF, MOTIF XS, S90 XS/S70 XS,
MOTIF-RACK

XS

and

MOX

synthesizers. It‘s a librarian for
Voices,
and

Performances,

Masters

which

Multis

helps

you

organize your sound collection in a
convenient way.
It’s also a complete editing environment
since it integrates with all the different

• It helps you auditioning the sounds of
a sound collection
• It helps you to reorder your sounds
via drag and drop. This feature is
reorganize their setlists!

particular Voice.

• It helps you to combine Voices,
Performances, Multis*, or Masters
from different files to create your own
“favorites” collections
• And last but not least it can convert sounds from different XS series
synths! This feature is particularly

Total Library Files:
These files can hold all the User Banks of
your synth. They support User Voices, User
Drum Kits, Performances, Multis*, and Mas-

nice for the MOX, which cannot

ters. Their capacity is limited to the capacity

directly load any XS series files!

of the synth’s memory, because they are
designed to have the exactly same structure.

TOTAL LIBRARIAN
Files

The main reasons Total Librarian was deve-

Total Librarian introduces two proprietary

loped and is appreciated are:

file formats: “Total Library Files” and “Voice

and recall them easily, without using

or to the synth. The support of comments
for each Voice makes it very easy to find a

Master Editor.

• It helps you to backup your sounds

the Voices to be sent to Total Library files

fantastic for live players who want to

XS series editors: Voice Editor, Drum Kit
Editor, Performance Editor, Mix Editor, and

as Voice “pools” from which you can select

Files”. It allows a unlimited number of files
to be opened simultaneously.

To create a new Total Library File select File
→ New Total Library from the main menu.
An empty file will be created.
To receive sounds from your synthesizer,
you have to select Edit → Receive All from

an USB stick. For example you can

Voice Files:

the main menu. The User slots of the file

use Total Librarian to save a single

These files can hold an unlimited number of

will be filled with the Voices, Performances,

Performance including the User

Normal Voices and Drum Kits. They serve

Multis*, and Masters of your synth.

Voices it uses and send it to a friend

*: Multis are supported for S90 XS/S70 XS and MOTIF-RACK XS only

EUROPE.YAMAHA.COM
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PATCH RECEIVE / TRANSMIT
If you want to transmit the Performance
“Piano Electro” to the synth, right click on it
and select “Transmit”.
To also transmit the User Voices it uses, select “Transmit Child Patches”.
The

same

applies

when

you

receive: You can receive the “child” Patches
of a Performance (the User Voices it uses)
by selecting the “Receive Child Patches”
command.

PATCH SORTING
As said above, Patches can be sorted by
name, category, and comment. Click on
the corresponding header of the Patch List
to perform the sorting.
So if you are sorting Voices used by PerforAs illustrated in the picture, Total Librarian

THE DEPEN DEN CY

provides an explorer-like interface, making

TRACKER

it easy to navigate through all the User
Banks.

mances, the Performances will be updated
automatically – thanks to the Dependency
Tracker.

Due to the architecture of the MOTIFs, Performances, Multis*, and Masters are not

PATCH REORDERING

For each sound (called „Patch“ in the Total

independent, but may point to other user

Total Librarian supports very easy Patch

Librarian) you can view and edit its name

created data. For example a Master may

reordering using drag and drop. This is a

and category and add or edit your own

point to a Performance which may point to

very valuable feature for live players whose

comments. Patches can be auditioned,

four User Voices.

setlists are constantly changing from gig to

initialized, copied, reordered, moved, sorted by name/category/comment, deleted,
received from the synth, or transmitted to
the synth.
Right click on a Patch to access all available
commands:

Total Librarian is aware of those connec-

gig!

tions between Patches and keeps those dependencies intact whatever you do with the
Patches.
You can check the dependencies by just
moving the mouse cursor over a Patch:

Simply select the Patches you want (multiple
selections are supported) and drag them to
As we can see in the screenshot, the Performance “Piano Electro” uses two User Voices
and is used by one Master. Total Librarian

a new place. Save the library file and transmit the Patches to the synth. Dependency

uses the Dependency Tracker in almost
every of its Patch manipulation functions.

EUROPE.YAMAHA.COM

Tracker is always watching!
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the User Voices it uses to the new file. Click

The importing function is quite straightfor-

on „Yes“. Now your new file contains the

ward. For example: To import a MOTIF XS

Performance and the User Voices it uses. If

All-file (*.X0A) into the MOX the following

you transmit the file to the synth (menu Edit

steps are needed:

This is more tricky to perform than simple

→ Transmit All) you will be able to hear the

• Open MOX Total Librarian

drag’n’drop reordering. The Copy/Swap

Performance correctly on the MOTIF.

• Create a new Total Library (File →
New Total Library)

command combination must be used.
Select one (or more) Voice, right click and

IMPORT AND

select “Copy”. Select the destination loca-

CONVERT NATIVE

tion, i.e. User Bank 2, slot 1 (A01), right

FILES

click and select “Swap”. Now the Voice(s)

• Import the MOTIF XS native file you
want (File → Import Native File)
• Transmit the imported data to the
MOX (Edit → Transmit All)

has changed position with the one residing

Total Librarian not only can receive Patches

You will then be able to play your XS Pat-

in the destination you selected and thanks

from the synth but it can also import them

ches on your MOX! However, there are

to the Dependency Tracker the Performan-

from the native files of the XS/XF series

some restrictions: Since the MOX does not

ces that use the Voices have been updated

synths. Since version 1.8.5 Total Librarian

support sampling, User Voices from the XS

automatically!

supports all XS/XF series synths formats:

containg samples are not available on the

• MOTIF XS (X0A, X0V, X0E)

PATCH COPYING TO NEW
FILE
When you copy a Patch to a new file,
dependencies are again recognized by

• S90 XS/S70 XS (X2A, X2V)
• MOTIF XF (X3A, X3V)
• MOX (X4A, X4V)

Total Librarian. Right click on a Perfor-

This feature is particularly perfect for the

mance and select “Copy”. Create a new

MOX which itself cannot import sounds

Total Library File (File → New Total Library)

from any XS series files! Now thanks to To-

right click i.e. on Performance Bank 1, slot
1 (A01), and click “Paste”.

MOX as you might expect them.

• MOTIF-RACK XS (X1E)

tal Librarian, MOX users are able to load XS
sounds - vice versa, the users of the other

Total Librarian will copy your Performance

XS/XF series synths are able to load MOX

and will also ask you if you want to copy

files!

FAQ
1. How do I connect the Total Librarian to
the MOTIF?
First you need to connect the MOTIF to the
computer (PC or Mac) via USB or Firewire
using the corresponding Yamaha driver you
can download from here:
www.yamahasynth.com/downloads

EUROPE.YAMAHA.COM
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Make sure your MOTIF is set up to communicate via USB or FireWire:
• On the MOTIF XS: Press [UTILITY]
• Press [F5] CONTROL

PRODUCTION

5. Who is the author of Total Librarian?
Total Librarian was developed by the 3rdparty Greek software engineer John Melas,
who is also a performing amateur musician

• Press [SF2] MIDI

and wanted to have a great tool for organi-

• Make sure MIDI IN/OUT is set to USB

zing his sounds and setlists!

or FireWire

John’s passion is to write powerful yet easy

Then use the Autoconnect feature of To-

to use software. He sees Total Librarian as

tal Librarian: From the Main Menu select

an indispensable tool for the studio and

MIDI → Autoconnect. Alternatively you can

performing musician. John hopes that it will

select the MIDI ports manually by selecting

help you to get the most out of your XS se-

Setup → MIDI Setup from the Main Menu.

ries synths!

As soon the connection is established you
will see a confirmation message in the
status bar of Total Librarian saying that your
synth is connected!
2. Do I need to be connected to work with
my files?
Your synthesizer only needs to be connected
if you want to audition or receive/transmit
Patches to/from the MOTIF. You don’t need
to be connected to the synth if you just want
to reorder Patches or combine different
Patches from different files, import a native
file, or rename your Patches etc.
3. What about arpeggios and samples?
Total Librarian does not manipulate, receive, or save User Arpeggios or Sample data.
This information resides only in the native
files of the MOTIFs and is not transmittable via MIDI. To manipulate Arpeggio and
Sample data please consider the Waveform
Editor:
www.jmelas.gr/motif/wave.php
4. Where can I download or buy the Total
Librarian?
Total Librarian is part of the XS Tools Complete Pack and you can download the demo
here:
www.jmelas.gr/motif/products.php
The restriction of the demo version is that
it cannot transmit Patches to the synth. You
can buy it separately for 35 EUR or included
in the Complete Pack (a complete editor/
librarian suite) for 95 EUR here:
www.jmelas.gr/motif/bundle_ord.php

EUROPE.YAMAHA.COM
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Yamaha Sy n t h G u id e
Part 1: synthesizers and workstations

For the past 20 years, Yamaha
releases free Quick Guides to their
respective new synthesizers, tone
generators, and workstations.
For several years, the Quick Guides are
integral parts of the Music Production
Guides (until August 2010 „MOTIF News
Guide“).
Since those guides and workshops were
mostly based on a specific model, we will

The following devices are primarily consi-

how does it differ from a synthesizer? There

dered:

are many questions like these - we want to

• MOTIF XF
• MOTIF XS

bring some clarity to the confusion.

• MOX
• MOTIF-RACK XS
• S90 XS

The Synthesizer
For centuries the sound generation of mu-

However, owners of older models such as

sical instruments based on natural mate-

the MOTIF „Classic“ or the MOTIF ES can

rials, such as wood, metal, natural furs,

also benefit from this workshop series,
since, as stated above, the basic sound

try and start a new concept in this series.

architecture is unchanged throughout the

Ten years ago, the first synthesizer of the

complete MOTIF series (including S-and

skins, or gut. The extended possibilities of
an alternative sound generation arose with
the electricity. Robert Moog is regarded as
a pioneer and inventor of the first synthe-

very popular MOTIF series was introdu-

MO-series).

ced. With the MOTIF 6 / 7 / 8 (or MOTIF

The workshop also wants to enable new-

„Classic“) began a success story that was

comers to the world of the MOTIF series

most recently continued with the MOTIF XF

to step beyond the basic operation. One

last century.

models and the MOX.

goal is to use the enormous potential of the

A trip into the detailed distinction between

A special feature of the MOTIF series is the

instruments and to optimize the workflow.

sizer, having constructed the first electronic
analog synthesizer in the mid-sixties of the

analog and digital technology would at this

continuity in its sound architecture and ope-

Let‘s start with some basic definitions. The

point deviate too far from the real issue.

ration. So if you have once understood the

variety of instruments that are played with

So - at the time of the first synthesizer the

device‘s concept you can apply this knowledge on the following models.

a keyboard is very broad. The question is:
What is a „keyboard“, what is a „workstation“? Where does a „stage piano“ begin, at

analog technology was the only available.
Analog technology results in almost infinitely variable signals. In contrast, the signal of

Considering this we had the idea of a uni-

which point is the term „master keyboard“

versal „Yamaha Synth Guide“, which covers

no longer applicable? What is referred as

the digital technology is always divided into

all eligible topics in a series and one by

„analog“ or „digital“? What instrument is

steps, each representing a fixed value of the

one.

called „ROMpler“ (Wave-ROM player) and

total possible value range.

EUROPE.YAMAHA.COM
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The Minimoog was one of the most popular and successful
models of synth history

The first synthesizers were monophonic

at fixed levels. However, today, every hybrid

„The sound engine of the CS80 based on

only, meaning they could always produce

is possible. There are units with a combi-

the analog subtractive synthesis, its 16 os-

nation of sound generation to operation in

cillators could generate two independent

only one tone at a time. They were also
built modularily. The sound generation was
done by at least one oscillator, additional
modules for the modulation of the sound
were such as filters and envelope gene-

all variants: Analog/analog, digital/digital,
analog/digital, and digital/analog.

sounds with eight voices each, which then
could be mixed. The other sound shaping
was done by a resonant envelope-con-

Going back to history. A major advan-

trolled high- and low-pass filter (12dB/

ce was the polyphony. The „Polymoog“

octave), a LFO (sine, sawtooth) and a ring

had six voices and no longer consisted of

modulator ... „

rators. All these terms are currently in our

modules. But it was not affordable for the

(translated from: http://de.wikipedia.org/

technical language, too. We will return to

„average musician“ from a house with ave-

wiki/Yamaha_CS-80)

these in detail later.

rage income. In a price list from the early

Thanks to the almost unlimited availability

80s the instrument was listed with about

of media and information any interested

The distinction between analog and digital

16.000 DM (sorry, I can‘t figure the equi-

reader can find much more comprehensi-

not only occurs in the signal generation, but

valent in your whatever currency in the

ve information about the development of

also in the operation of electronic musical

early 80s. In 1982 one US-Dollar was worth

electronic instruments and different forms

instruments. Traditional synthesizers from

about 2,40 Deutschmark. However, a new

the early days were operated analogous.

car like the middle class Mercedes Benz

For we want to make a time jump to the

190 or W201 costed about 26.000 DM in

here and now. What is it that justifies the

1982).

term „synthesizer“? To get to the point:

They had rotary or sliding controls (poten
tiometers) to alter values, the modules were
connected using cables. Modern digital
equipment operation can be done with the
help of push buttons to change values, and

A milestone in the development of the polyphonic synthesizer was the Yamaha CS-80,
which came on the market in 1977. Unlike

of synthesis.

A very clear line can barely be drawn.
Let us first consider the core of the question: the basis of sound generation. Before the era of sampling the sound of every

the Polymoog or other polyphonic synthe-

knobs and faders work digitally, allowing

synthesizer was produced by at least one

sizers from this time, the CS80 no longer

oscillator. Today the vast majority of sound

changes within the given value range only

based on organ technology.

generation is based on samples.

EUROPE.YAMAHA.COM
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Now, a sample - in contrast to an

used to create extremely complex sounds

pre-produced audio or MIDI data.

oscillator - can already include all possible

with - to express it traditionally - up to 128

modulations and effects etc. So a machi-

A workstation‘s sequencer can record mul-

oscillators. I‘m not sure if Mr. Moog has da-

tiple tracks, extensively edit the recorded

red to have this vision at his time.

data, delete or add individual data, resolve

ne that plays back ready-made samples is
sufficient to generate sound. Such equipment is called a sample player, ROM sam-

So the preliminary summary is: Every

ple player, or in short „Rompler“. Only the

instrument from the MOTIF / S / MO / MOX

possibility of actual sound processing, for

series includes a full-fledged synthesizer.

example using filters, envelopes, LFOs, etc.
allows the comparison to the original synthesizer.
Whether the - as an example - sine wave

and sampling

is the result of playing back a sample can

workstation to perhaps as a „machine

be neglected at least for the terminology. It

doing the main workload“. If you enter the

any processing. But it is this sample that

dio data is possible.
The latter leads us to another option of the

Samplers were also separate devices in the
past. They were used for recording, editing

Taken literally, one might translate the term

in principle sound like a saxophone without

and much more. Even the integration of au-

workstation: sampling.

The workstatio n

is generated directly from an oscillator or

is obvious that a saxophone sample should

the recordings in pattern or song structures

term in Wikipedia, you get the explanation
of a powerful computer system.

and playing back audio data, but not in
the style of a tape recorder. The audio data
was cut into small individual samples, then
edited and prepared to be played with a
keyboard or the pads of a drum machine.
For the proper processing of the recorded

may result in sounds, that can‘t be achie-

Strictly speaking the workstation for us

audio data (graphical representation of the

ved with a traditional oscillator (or only with

musicians

electronic

waveforms) the first samplers had their own

much effort), if it is processed by the modu-

instruments

computers

monitors or at least a monitor connector.

lation capabilities of a synthesizer.

that are restricted to musical applications.

Many modern workstations, including the

Keeping that in mind we can make abso-

They become a „machine“ by the enhan-

lutely clear that the sound generation in

cing combination of applications that go

each of the instruments discussed in this

beyond just playing sounds. In principle,

workshop series can definitely be called a
synthesizer.
A closer look at the Yamaha editor soft-

is

both.
are

Modern

specialized

one can see it again as a modular system,
only within a single unit.

MOTIF series from „classic“ to XF, feature a
full-fledged sampler, which can perform all
necessary edits directly on the instrument.
Additional options of a workstation - but
not limited to - can be master keyboard
functions, that make it possible to control

An important component which elevates a

multiple instruments and expanders from a

synthesizer to a workstation is a recording

single keyboard.

to oscillators) within a Voice offers to pro-

and playback ability. So a built-in sequen-

The remote control of a computer software

cess and modulate a signal. Both the pre-

cer has probably the widest distribution for

such as Cubase can be part of a work

sets as well as the „sample-free“ versions of

that purpose.

station, too. (A brief glance here: Softwares

ware shows the vast variety of parameters
that each of the up to eight Parts (similar

optional soundsets include plenty of great

The MOTIF XF is the current top model of the MOTIF-series

examples.

In earlier times generally available as a

such as Cubase, Logic, Ableton Live, Pro-

The ability to play 16 Voices in parallel has

standalone device, the sequencer is used

Tools and many more are often referred to

not necessarily to be used as a multi-mode

in a workstation for recording and editing

as a DAW = „Digital Audio Workstation“

for working with MIDI files. It can also be

your own performance and playing back

- so here‘s this term, too.)

EUROPE.YAMAHA.COM
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As already indicated, the diversity of the
electronic musical instruments currently on

This term is mostly used for the keyboardless versions of a synthesizer, sampler, or
even a workstation. Only the development
of the MIDI protocol, including its interface,
made it possible to „outsource“ the tone

the market rarely allows an unambiguous
classification. In some contexts, for example
the term „keyboard“ alone means the arranger or entertainer keyboard. There are
of course some „hybrids“, like arranger
workstations, stage pianos, performance
synthesizer, home keyboards. There is no

generation of an electronic instrument into

end in sight.

a separate unit. A good example is the

For the instruments with which we want to

milestone-synthesizer Yamaha DX7.

deal in this workshop, in any case the term
synthesizer shall fit.
Apart from the MOTIF-RACK XS the term
workstation is applicable, too.

Coming
next
In the next part of
this workshop series
we will discuss the
history of the MOTIF
Published in 1983, the Yamaha DX7 turned the synthesizer series. In addition to
world upside down and even pushed legends like describing the deMoog synthesizers or Oberheim to the background velopment from the

MOTIF „Classic“ to
Some time after the introduction of the

the XF, we will also

DX7 in 1983 the TX-816 was introduced,

discuss the compatibility of the devices with

being a 19“ expander, which could accom-

each other and give advice on upgrading.

modate up to eight TF-1 modules. Each of
these modules corresponded to the full
tone generation of a DX7. However, this
system was not available for those with a

The Authors

small budget. The first expander sound modules were in their majority determined on

Peter Krischker			

a particular instrument. For example there

Works for Yamaha since 1991 as a sound designer and

were expanders used exclusively for piano,

synthesizer specialist, he also runs his own sound distribution

organ, or drum sounds. Only in the course
of time many keyboard versions were offered in a 19“ rack version, too.

EASY SOUNDS.
pkrischker@t-online.de
www.easysounds.de

A typical application of sound modules has

Hans-Peter Henkel (alias hape13)

been playing back standard MIDI files of

Keyboardist in several bands since 32 years. Is also involved

different formats, like GM, GS, and XG. For

as a mentor at the Yamaha Synthforum and author for the

Yamaha‘s advanced XG standard, there

Music Production Guide.

were some models of the MU series. The

hp@hape13.de

most current sound module covered with

www.hape13.de

this guide is the MOTIF-RACK XS.
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Yamaha i P a d -App :
MOTI F X F Voic e Edi t o r E s s e n t i a l

With this third episode on the topic

Then format an USB stick with at least 256

The process itself will take several mi-

MOTIF and iPad I would like to

MB capacity directly on the instrument.

nutes and ends automatically with the

introduce the Voice Editor Essential
to you. In the last issue a wired
connection between the instrument
and the iPad was used. In addition

message „Finish. Please turn off.“. So
[FILE] → [F3] Format → [ENTER]

turn off the MOTIF, remove the USB

Please copy the update file you downloa-

stick from the port, and check the suc-

to the Voice editor I like to use the

ded earlier from www.yamahasynth.com

wireless Wi-Fi connection.

onto this USB stick - there should be no

The following paragraphs apply to all
apps described in Music Production Guide
07/2011, but exclusively in connection with
a MOTIF XF running firmware version 1.20
and higher.

further data on the stick.

switching

the

[UTILITY] → [UTILITY]+[CURSOR UP]+[F1].
A compatible USB WiFi adapter is required

not interrupted and of course don‘t turn off

fully tested WiFi adapters can be found at

the instrument in any case during the up-

http://download.yamaha.com/file/48197

If necessary turn the MOTIF off now to start

If you have not installed the required firm-

the update, connect the prepared USB stick

ware update for your MOTIF XF yet, this

to the MOTIF and turn it on again while

would be the perfect moment.

holding the two buttons [CURSOR UP] and

by creating an ALL file including the

after

for a wireless connection. A list of succes-

Assuming ...

do a complete backup of your data

update

MOTIF on again using the key combination

Please make sure that the power supply is

date process.

ATTENTION: Prior to each update please

cessful

There are different methods to establish
a wireless connection. For some types of
connections extensive knowledge about
computer networks are needed that can not
be provided as part of this guide. For this
reason, we will restrict ourselves to the

[UTILITY] pressed down simultaneously. Af-

direct

ter startup, the logo „MOTIF XF“ will appear

between the instrument and the iPad.

connection

(Ad-Hoc

connection)

in the display, the update process begins
with searching the file on the stick. The dis-

Radio operator

on an USB stick, which you then also

play will show the message „Searching for

First, please connect the USB WiFi adapter

backup on the hard disk of your computer.

the firmware updater, indicating ...... %“.

to the „USB TO DEVICE“ port.

Waveforms (FL1 and FL2 „with sample“)
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You can also use an USB hub (USB signal

settings, once done the message „Comple-

[MIDI Type]: „wireless“ → [Model Select]:

distributor) to be able to connect additional

ted“ appears in the display. Now everything

„MOTIF XF...“ → [Wireless MIDI Port]: „MO-

USB devices such as USB sticks, too.

is prepared for a connection. Finally, you

TIF XF...“
If the pairing was successful, the MIDI IN
LED at the top right of the display starts to
light up green.
You

can

now

start to actually
work

with

the

app. If you want
to work with multiple apps in parallel and
have already configured their connection
settings properly, you can toggle between
On the MOTIF XF you have to make the fol-

need to enable the network operation as

lowing settings to prepare a wireless con-

the basic connection method of the MOTIF.

nection:

Utility Settings
MOTIF XF:

Utility- Settings on the
MOTIF XF:

a row up. Below the dock all apps are listed

• Navigate with cursor [▼►]  and

[INC / DEC] to make the following

cations: Do a „double click“ on the home

• Press [F5] (Control)

• Press [F1] (General)

• Navigate with cursor [▼►] and

One tip for a fast toggling between appli-

button to shift the whole screen of the iPad

• Press [SF2] (MIDI)

[ENTER]

tically set up when the app is started.

• Press [UTILITY]

• Press the [UTILITY] button
• Press [SF3] (Network) - activate with

apps. The Wi-Fi connection will be automa-

[INC / DEC] and make the

that were not explicitly terminated, but run
in the background. On the far left the most
recently used application is displayed. So

following settings:
• Interface

you can toggle very quickly between two or

• Set „MIDI In / Out“ to „network“
There are also some settings required on

more programs by double clicking on the
home button and selecting the icons loca-

settings:

the iPad to be able to connect to the MOTIF.

• Interface

Open the program „Settings“ and follow

• „Device“ to „wireless“

these steps:

This part is generally valid for all Yamaha

• Navigate with cursor [▼]

[General] → [Network] → [Wi-Fi]

iPad apps, with the exception of the Set List
Editor. In the following parts of detailed

• Confirm „Wireless Settings“ with
[ENTER]

program descriptions a wired or wireless

• Configuration Mode → „ad hoc“

connection between the instrument and the

• Security → „off“
• Confirm Settings with → [ENTER]

iPad is assumed.
Establish a connection to „MOTIF_XF ...“
by tapping on the

Wireless -NetworkSettings MOTIF XF:

entry.

• Navigate with cursor [▼]
• Set „Security“ to „off“
• Confirm the settings with [ENTER]
It will take a few seconds to enable the new

EUROPE.YAMAHA.COM

at first glance

you want to work

[INC / DEC] and make the following
• „Configuration Mode“ to „ad hoc“

Voice Editor
Essential -

Now start the app

• Navigate with cursor [▼►] and
settings:

ted on the left.

some

The aim of the editor-app is a fast and com-

small adjustments to the connection confi-

fortable adjusting of the parameters using

guration are required, too. Please tap on

the appealing graphical interface com-

the gear-wheel in the top right of the dis-

bined with touch screen operation. It offers

play to call up the menu with the parame-

a very intuitive and completely risk-free

ters. The further steps and settings are as

work, unless you press the [STORE] button

follows:

on the instrument.

with.

Here
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1st Time Hands On
First select a free memory slot in the app,
for instance by tapping on the plus or minus button next to the field containing the
program‘s name.

quickly create new variants of a Voice and

You can also tap directly on the name to get

Therefore a tip on the value opens an ad-

save them in the app, independently from

a list view, from which you can make your

ditional horizontal fader, ready to use for

the memory contents of the instrument.

selection. Enter a new name by tapping on

accurately setting the value.

Tapping on the „RECEIVE“ button will aks

view and replacing the existing name (Ini-

the small blue arrow from the above list

you in return: „Confirmation - Are you
sure?“ If you confirm by tapping on „Yes“,
the currently selected memory location of
the app will be overwritten with the current
data of the instrument. There is no undo!
In the top left the buttons labeled „RECEI-

tialized setup) in the box that opens. Below

So if you have already worked with the ap-

the memory selection you‘ll find the but-

plication and don‘t want to lose the current

tons „VOICE“, „DRUM“, and „PROGRAM

settings, you should first select a free me-

SELECT“.

VE“ and „TRANSMIT“ can be found. With

mory slot in the app.

„RECEIVE“ the settings of the current Voice

Right after the data transfer it is advisab-

Tap on „PROGRAM SELECT“. Here you are

le to assign a unique name to the selected

able to select a Voice from the instrument‘s

in the MOTIF are loaded into the program,
but without the name of the Voice.

memory slot, so you can be sure to not accidentally overwrite anything important in the

For this example „VOICE“ should be active.

memory. You can use the Bank-oriented display or have the Voices sorted by
„CATEGORY“.
If you want to follow the coming steps,
please select a Voice from the main
category „Pads“, sub-category „Warm“. By
tapping on an entry in the list the Voice is

If you now make a change to the parameters, they will be sent immediately. You can
tell that by the yellow „E“ on the top right
of the display on the MOTIF, like when you
are working directly on the instrument. These transfers only affect the edit buffer. All
changes are only saved in the user memory
by performing the [STORE] operation.

next session.
If you are not sure whether the settings in
the current memory slot are important or
not, you can simply transmit them to the
MOTIF without the risk to overwrite anything
there.

automatically selected in the instrument
and can be played immediately. I want to
prepare a Voice for a Piano-/E-Piano sound
layer. For example, the Voices from the
preset memory PRE4:032 to 046 in that
category are basically suitable for layers,
039 best illustrates the desired effect.

Apart from selective edits the Voice

Quite centrally at the top there‘s a typi-

Editor

cal choice of storage locations. You can

provides a wonder-

change the memory location by tapping on

ful opportunity to

the plus and minus buttons or by tapping

create

on the field containing the name to get a

variations of a Voice

list of choices. When selecting a new me-

or

mory location, the content is not sent im-

Voices into line in

mediately, you have to use the „TRANSMIT“

a certain area. To

function. There are 50 memory locations to

interrupt the dry text

provide you with your unique settings and

at this point, here‘s

names. At this point, maybe a little bit of

a simple practical

interpretation to the operation is advisable.

example.

bring

Essential

interesting
multiple
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All these Voices respond to the use of the

It is the „RECEIVE“ function that loads the

With the tab „ARP/KBD Control“ you

sustain pedal with heavy overlays. After you

corresponding parameters into the iPad

get a comfortable access to the ar-

have made your choice, press the „CLOSE“
button in the top right.
Play a few notes using the sustain pedal
to hear the overlays. Then select the tab
„FADER CONTROL“, which is located below
the tempo display. The display screen chan-

app. So this is the right way if you want to
edit and store all parameters of a Voice in

peggios.

Scrolling

in

long

lists

is

the iPad. However, it may also happen that

designed to be easy and quick, it also benefits

you want to specifically change a certain

from the category sorting.

parameter in several Voices. In this case,
you would do it without sending and recei-

The „Effect“ and „EQ“ tab allow what you

ving all parameter sets. You simply select

would expect from them. You have access

the Voice on the instrument, change the

to the circuitry of the effects, Send and Re-

ges and you will find sliders for filter, reso-

appropriate parameter to the desired va-

nance, and the amplitude and filter envelo-

lue using the app, and then store the made

turn levels and Pan positions. By tapping

pe generators. Reduce the parameter „AEG

change in the instrument. Select the next

on the respective buttons „CHORUS“ and

Voice, do the change, and store the Voice

„REVERB“ you are able to select effect ty-

DECAY“ by up to -64, depending on your
taste, and in parallel test the behavior of
the Voice by playing with the sustain pedal
depressed. If you are satisfied with the result and want to save the changes you could

on the instrument. It‘s a very quick way for
selective adjustments.
For a fine-tuning of Voices you might take

GORY“, and „PRESET“ a clear selection list

ter setting in successive memory locations

view is opened.

of the app and

„STORE“ button. But consider the possibility

compare them by

to first try different settings by storing them

transmitting them

ply changing these slots you can experience

typing in the name fields „TYPE“, „CATE-

„snapshots“ of slightly different parame-

create a User Voice by pressing the MOTIF‘s

in different memory slots in the app. By sim-

pes and edit their parameters in detail. By

one at a time to
the

instruments.

The result is a si-

and compare the effects on the instrument

gnificantly expan-

before finally storing the best possible set-

ded

ting in the MOTIF.

functionality,

COMPARE
or

you might consi-

A few thoughts...

der using it as a
multiple UNDO.

Here are the different methods with or without using the „TRANSMIT“ and „RECEIVE“

What

buttons to compare them again: By selec-

else is

ting a Voice using „PROGRAM SELECT“

there?

The „EQ“ is also designed really appealing.

only the referencing memory location in the

The Voice Editor Essential includes many

Of course, the setting of frequencies, gain,

tone generator is activated.

more possibilities. To present them all in
detail is beyond the
scope of this article.
Since on one hand

sponding controls. The real fun however

the app can be used

is to directly tap into the XY area to move

immediately

the colored points for „LOW“, „MID“, and

and

very intuitively, and
on the other hand

„HIGH“. Doing so you are able to adjust

it newly visualizes

frequency and gain in one go. With a two-

features

familiar

from the instrument
to operate them by
the touch screen,
I would like to explain some of the
other features in a
brief overview.

EUROPE.YAMAHA.COM

and Q-factor is possible using the corre-

finger gesture - which in other apps is typically used to zoom in and zoom out of images, texts, etc. - you can adjust the Q-factor
of the EQ band: Contraction increases the
Q-factor and vice versa.
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The tab „XY CONTROL“ contains a reduced
version of the XY pad from the separately
available app „Faders & XY pad“. From a
list of 21 controller numbers you can simultaneously assign five to the blue ball in the
XY pad. The ball can then be moved over
the field to change the assigned controllers
in relation to the position. The direction of
parameters can be inverted with a switch.
You can also „snip“ the ball to get random
controller motions. By adjusting the „BALL
MOTION TIME“ you can influence the duration of the movement. The minimum value (blue marker on the left) stops the ball
at the position you release it. The maximum
value results in a endless continuous movement. You can stop the ball and reset it
to the central zero-position by using the
„RESET“ button.
I would be happy if this article has sparked
your interest or encouraged you to experiment. I hope you enjoy this new form of
Voice editing.
Don‘t miss the next episode, until then
I remain with best regards,
Hans-Peter Henkel
hp@hape13.de
www.hape13.de
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C P & S -S er i es
Tr ade -Up P r og r a m m e
Exchange your old digital or
acoustic piano for a beautiful
new Yamaha CP Stage Piano or a
S-series synthesizer and receive up
to 1,000 EUR off the price.
Qualifying

consumer-exchanged

instru-

ments are as follows: Digital Pianos, Stage
Pianos, Acoustic Pianos & Grand Pianos.

Trade-Up-Bonus

The instrument taken must have a weighted

CP1

1,000 EUR

keyboard with 88 keys.

CP5

300 EUR

S90 XS

300 EUR

CP50

200 EUR

S70 XS

200 EUR

The total amount of trade-in value towards
a CP1 is not to exceed 1,000 EUR. Towards
a CP5 or a S90 XS the trade-in value is
300 EUR max. For a CP50 or S70 XS the
value is 200 EUR max. The total partexchange price offered will be at the discretion of your Yamaha Dealer.
The Yamaha Trade-Up Programme cannot
be combined with other promotions.
Ask your Yamaha dealer for the exact conditions.

The promotion period starts on
1 November 2011 and ends on
31 March 2012
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DTX- Wo r k s hop : S e t t i n g u p
Hi- Hat a n d Cy m b a l P a d s
In this DTX workshop I want to get across to you how to best set up and align Yamaha cymbal and hi-hat pads.
Because this will result in maximum performance and absolute fun. Here we go!
Tip: Did you know that our cymbal pads can be played on the DTX700 & 900 even if you hold them choked? Try and grab a cymbal pad,
hold it and strike it with the stick... then comes the aha effect!

Setting up Cymbal Pads
1. Please remove the wing nut, the two cymbal felts, and the

5. Place the big felt on top of the cymbal and pad holder and tighten

plastic cymbal holder.

the cymbal with the wing nut.

2. Attach the cymbal lock
to the bottom of the bracket
and tighten the screw lightly

6. Now align the cymbal and properly tighten the screw on the

with a drumkey. The lock is

cymbal lock.

securely tightened after the
final

alignment

of

the

cymbal.

3. Now screw the plastic holder back on the cymbal bracket and
put a small cymbal felt on it. The second felt is obsolete and is
replaced by the larger one later.

7. The cymbal pad works best in the area of the logo (see marking).
That‘s why the lock is so important, it ensures the cymbal pad is
always in the optimal playing position.

4. Now place the cymbal on the pad holder.

EUROPE.YAMAHA.COM
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Setting up Hi-Hat Pads

1. Remove the top hi-hat holder and the cymbal felt. Both are no

5. Now assemble all the pieces back together in the correct order

longer needed.

and then tighten the screws. Important! After you have tightened
all the pieces, properly tighten the square screw with a drumkey.

2. Now place the lower part of the hi-hat controller on the hi-hat
stand. The soft foam underside replaces the cymbal felt. The large
contact surface is facing up.

3. Now remove all the parts from the hi-hat pad holder except
the last felt.

6. Now you can put the hi-hat pad with its attached holder onto
the hi-hat machine. The hi-hat rod should be tightened so it can‘t
rotate. The perfect playing position on the hi-hat pad is in the area
of the logo. So turn the hi-hat pad to the correct playing position.
7. Set the desired distance from the lower contact surface and
firmly tighten the wing nut of the hi-hat pad holder.

4. Insert the hi-hat pad holder from below into the cymbal pad.

Now have fun with your perfectly set up cymbal pads!
Yours Ralf Mersch
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Mus ic Pr oduc t ion G u id e s –
complet e a r chi v e o n l i n e

On the last page of the Music Production Guide a link can
be found to download a zip-file containing all previous
editions (in the Box „Music Production Guide History“).
In addition, we now offer all readers the opportunity to access all previous issues online. So the Guides archive is available from everywhere
you‘ve got connection to the internet.
After entering the access data, simply click on the relevant issue in
order to open it for reading.
The link to the German editions:
http://easysounds.macbay.de/MusicProductionGuides_DE
The link to the English editions:
http://easysounds.macbay.de/MusicProductionGuides_EN
Login:
Name: musicpro
Password: guide
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Ne w Ya ma h a Goodi e :
MOX „Soun d & G r oov e Kit “

The free MOX „Sound & Groove Kit“ is now available for all registered users of the MOX.
This soundset includes an „Electronic & Dance“ soundlibrary featuring 128 Voices - a selection of the best synth-sounds from the EASY
SOUNDS soundlibraries for the MOTIF series.
In addition, the package includes a WAV loop pool with drums, synths, vocals, sound effects and atmospheres for Cubase AI and other DAWs.
Registration for this goodie is done by writing an informal e-mail with the keyword „MOX“ to this e-mail address:
motifnews@easysounds.de

EASY SOUNDS Soundsets for MOX
The popular MOTIF soundlibrary from EASY SOUNDS will be available shortly in the MOX format.
The following products are in preparation:
• Yamaha MOX „Xtasyn“
• Yamaha MOX „Synth Xtreme“
• Yamaha MOX „Magical Pads“
• Yamaha MOX „Stage & Studio“
• Yamaha MOX „Phat Analog“
• Yamaha MOX „Organ Session“
• Yamaha MOX „Hypnotic Stepz“
• Yamaha MOX „Chill Xperience“
• Yamaha MOX „Mystic Spheres“
• Yamaha MOX „Dance Xpanded“
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Y a mah a CP 1 A r t i s t P e r f o r m a n c es
A free soundset available in excellent quality is now abvailable for every CP1 user.
A total of 64 Performances were programmed by renowned sound designers Johannes Waehneldt and Peter Jung on behalf of Yamaha Music
Europe.
The soundset can be requested by sending an e-mail to
motifnews@easysounds.de
containing the keyword „CP1 Artist“.
You will receive an e-mail from EASY SOUNDS containing a link where the file can
be downloaded.
In addition you are automatically registered for the free subscription of
the monthly Music Production Guide.
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Fl as h M emo r y
Conte n t fo r
MOTI F X F

Yamaha is working with third party
software vendors (KEYFAX, EASY
SOUNDS, DSF, SONIC REALITY)
to offer an extensive amount of
free and optional Flash Memory
content.

User Voice Bank 2 –
Yamaha Bank

From the first day of delivery all registe-

User Voice Bank 3 –
Third Party Bank

red MOTIF XF users will have access to a
free download file containing a first stock
of Samples to build their own expandable sample library for the non-volatile Flash
Memory of their MOTIF XF.

User Drum Voice Bank
The User Drum Voice Bank features

A selection of additional Voices from the
Yamaha Library: S700 piano, organs,
brass & reeds, sweet voices, pads.

twelve new Drumkits (Acoustic Drums,
Oriental Percussion, Hip Hop, House...)
These Voice Banks can be individually
loaded into the volatile SDRAM of the
MOTIF XF, if no Flash Memory Module is

Organs, synth leads, synth comps, synth
strings, pads, atmospheres... A Voice
selection

from

the

sound

libraries

installed.
It is also recommended to load the Voice

of DCP PRODUCTIONS and EASY

Banks into the SDRAM for a quick audition

SOUNDS. This Bank for instance inclu-

of the material before loading them into the

User Voice Banks, 353 User Waveforms,

des 32 Voices from the EASY SOUNDS

Flash Memory.

458 MB of Samples and 12 User Drum Kits

Libraries „Organ Session“ and „Phat

(Oriental Drums & Percussion).

Analog“ each.

This Content Package contains three new

Here is an overview of the Voice Banks
contained in the Flash Memory Content
Package:

User Voice Bank 1 –
Factory Content

This free Flash Memory Content can be requested by sending an e-mail containing

User Voice Bank 4 –
Oriental Instruments

the keywords „MOTIF XF Flash Content“ to:
motifnews@easysounds.de

128 Oriental instrument Voices, with
micro-tuning, mainly programmed by

The MOTIF XF user will receive an e-mail

the Turkish musician Mert Topel. If you

from EASY SOUNDS with a password and

want to play these Voices with a „nor-

a link where the file can be downloaded.

Contains the same content of the new

mal“ tone scale, go to VOICE - EDIT -

MOTIF XF Factory Bank. That‘s why no

COMMON EDIT - F1 General - SF2 Play

additional Flash Memory content is ad-

Mode and set the parameters Bank to

red for the free monthly Music Production

ded to this Bank.

„pre“ and Tuning Number to „1“.

Guide..

In addition you are automatically registe-
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MOTI F X S E ur op e a n
Loy alt y P r ogra m
V ers io n 2
The „European Loyalty Program” offers MOTIF XS users free additional but
nonetheless high-class content.
It is mainly a premium Voice and Samplelibrary which is produced by EASY SOUNDS in
collaboration with Yamaha Music Europe and contains the following:
• The 3-layers Yamaha S700 stereo piano (32 MB compressed) of the Yamaha S90 ES
which is known as the ultimate piano sound from Yamaha synths. The Piano is featured
in different variations (e.g. Brite, Dark, Ballad Stack)
• „Sweet Voices“ from the Yamaha Tyros (Trumpet, Trombone, Saxophone, Panflute...)
• New Choir and Scatvoices
• Best-of compilations of optional soundsets from EASY SOUNDS (synths, pads &
atmospheres, organs...)
• Best-of compilation of the Xpanded series from Yamaha Europe (converted from
MOTIF ES)
• A WAV pool containing 200 WAV files with 93 MB in total. These are drum loops,
vocal and vocoder phrases, sound effects, and atmospheres
Furthermore the Loyalty Program contains a comprehensive MOTIF XS Quick Guide in PDF
format. This Quick Guide is compiled of all XS articles and workshops from the MOTIF News
Guide.
To register for the Loyalty program simply write an e-mail with the keyword „MOTIF XS Loyalty
Program“ to:
motifnews@easysounds.de
As soon as the registration process is complete the MOTIF XS user will receive an e-mail from
EASY SOUNDS with a password and a link where the file can be downloaded. The size of
the download file is 221 MB.
In addition you are automatically registered for the free monthly Music Production Guide.
Alternatively the „European Loyalty Content Package“ can be delivered on an USB memory
stick, which must be ordered for a reasonable price from www.easysounds.de in addition to
the e-mail procedure mentioned above. Remember to add the keyword „MOTIF XS Loyalty
Program“ to your USB memory stick order.
Already registered MOTIF XS users can request an update by sending an e-mail to:
motifnews@easysounds.de
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MOTI F X S Soun d s e t : “O r i e n t a l
Instr umen t s & P e r c u s s ion ”
MOTIF XS users can enjoy a free
soundset: „Oriental Instruments
& Percussion“ can be downloaded
from Yamaha Music Europe in
cooperation with EASY SOUNDS.
The soundset contains the following:

Authentic samples of oriental musical inst-

The MOTIF XS user will receive an e-mail

ruments plus the most popular turkish Mic-

from EASY SOUNDS with a password and a

ro Tunings are the basic building blocks of

link where the file can be downloaded. The

this soundset.

size of the download file is 66 MB.

Nonetheless these special oriental instruments can be used in music styles like pop,

• 36 Performances

world, chill out, ambient and whatever you

• 128 Voices

can imagine.

• 9 User Drum Voices

The 128 Voices and 36 Performances are

• 113 User Waveforms of oriental

mostly built from the new User Waveforms

instruments
• 84 MB Samples
• 6 Turkish Authentic Micro Tunings
„Oriental Instruments“ has been produced
by turkish musicians and is developed for
the use in both traditional and modern tur-

In addition you are automatically registered for the free monthly Music Production
Guide.
Alternatively the „European Loyalty Content Package“ can be delivered on an USB
memory stick, which must be ordered for a
reasonable price from www.easysounds.de

and Samples. Some Voices are modified

in addition to the e-mail procedure men-

Preset Voices.

tioned above. Remember to add the key-

This free soundset can be requested by
sending an e-mail containing the keyword

word „Oriental Instruments“ to your USB
memory stick order.

„Oriental“ to:
motifnews@easysounds.de

kish music.

S90 XS / S 7 0 X S :
Soundpa c k a g e
A

free

„Soundpackage“

with

additional high-class content is
available for S90 XS / S70 XS users.
This Soundpackage is produced by EASY
SOUNDS under contract to Yamaha Music
Europe and contains the following:

Pop & Dance
This Voice Bank features 128 profes-

Vocoder Dreamz
The S90 XS / S70 XS version of „Vocoder Dreamz“ features 40 Vocoder Voices

to:
motifnews@easysounds.de

and a comprehensive manual on how to

You will receive an e-mail from EASY

use them with the S90 XS Vocoder. The

SOUNDS with a password and a link where

User Voice Bank is divided as follows:

the file can be downloaded. The size of the

• 1 – 16 Vocoder Voices (Vocoder +

download file is 136 MB.

Pad/Atmo/Synth)
• 17 – 36 Vocoder Voices (Basic Type)
• 37 – 40 Vocoder Voices (LFO-Type)

sional User Voices compiled from popular EASY SOUNDS libraries for the

keyword „S90 XS / S70 XS Soundpackage“

WAV-Pool

In addition you are automatically registered for the free monthly Music Production
Guide.
Alternatively the Soundpackage can be
delivered on an USB memory stick, which

MOTIF XS and the MOTIF ES Xpanded

The WAV pool contains 200 WAV files

series from Yamaha Europe converted

with a total size of 93 MB. These are

from www.easysounds.de in addition to the

for the S90 XS / S70 XS.

drum loops, vocoder phrases, sound ef-

e-mail procedure mentioned above. Re-

fects, and atmos.

member to add the keyword „S90 XS / S70

The set „Poc & Dance“ contains Voices
from these EASY SOUNDS soundsets:
• Chill Xperience
• Dance Xpanded
• Magical Pads
• Mystic Spheres

must be ordered for a reasonable price

XS Soundpackage“ to your USB memory

News Guides

stick order.

All already published editions of the
„Music Production Guide“ are included
in PDF format.

• Stage & Studio

This free soundpackage can be reques-

• Synth Xtreme

ted by sending an e-mail containing the
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MOTI F-RA CK X S :
Sound & In fopa c k a g e
MOTIF-RACK XS users can obtain the free „Sound & Infopackage“ that‘s produced by EASY SOUNDS under contract
to Yamaha Music Europe.
The software package contains the following:
• Soundset „POP & DANCE“ with 128 professional Voices
• WAV-Pool with 200 loops and audio-phrases
• Demo song
• PDF file of a comprehensive guide plus tips & tricks  
This free soundpackage can be requested by sending an e-mail containing the keyword „MOTIF-RACK XS Sound & Infopackage“ to:
motifnews@easysounds.de
You will receive an e-mail from EASY SOUNDS with a password and a link where the file can be downloaded.
The size of the download file is 125 MB.
In addition you are automatically registered for the free monthly Music Production Guide.

S 90 ES , M O T IF -RA C K ES, M O :
Sound li b r a r i es
Users of the MO6 / MO8, S90 ES, and MOTIF-RACK ES can obtain a free Sound & Infopackage that‘s produced by
EASY SOUNDS under contract to Yamaha Music Europe.
This includes the soundset „Pop Xpanded“ with 192 profesional live- and arpeggio-sounds. For details on this soundset see the box to the right.
Furthermore a comprehensive documentation of the soundset, Quick Guides, demo-sounds, and other useful files are included.
This free soundpackage can be requested by sending an e-mail containing the keyword „Pop Xpanded“ to:
motifnews@easysounds.de
You will receive an e-mail from EASY SOUNDS with a password and a link where the file can be downloaded.
The size of the download file is 13 MB.
In addition you are automatically registered for the free monthly Music Production Guide.
User Voice Bank 1 is identical to „Arp Xpanded“ and features 128 Voice based on 106 new User Arpeggio Phrases. (In the MOTIF-RACK ES
version the Arpeggiator is deactivated, since the RACK has no User Arpeggios.)
Voices 1 – 64 of the User Voice Bank 2 are identical to the 64 „Live-Voices“ of „Live Xpanded“. These are keyboard and synth sounds which
are specially programmed for pop, rock, dance, and live entertainment.
The Voices 65 – 128 of the User Voice Bank 2 are compiled by the best synthesizer sounds of the factory preset sounds from the MOTIF ES
and MOTIF-RACK ES.
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MM6 / MM 8:
Sof twa r e-P a c ka g e „ Liv e & S t u dio“
Users of the MM6 and MM8 can
obtain the free software package
„Live & Studio“ that‘s produced by
EASY SOUNDS under contract to
Yamaha Music Europe.

The Song templates contain setup data in

You will receive an e-mail from EASY

formats for Cubase, Logic, and standard

SOUNDS with a password and a link where

MIDI file (SMF). They feature SysEx events,

the file can be downloaded. The size of the

Bank Select, Program Change, and Con-

download file is 131 MB.

troller events which set the effects and

In addition you are automatically registe-

The software package contains the fol-

sounds of the MM6 / MM8 to be controlled

red for the free monthly Music Production

lowing:

in „PC-Mode” with 16 MIDI channels (mul-

Guide.

• MM6 / MM8 Live Peformance Bank
• Song templates
• Demo song with audio and MIDI
tracks for Cubase, Logic, Standard
MIDI File)
• WAV loop pool for Cubase + Logic
(drums, synths, vocals, effects, atmos)
• MM6 / MM8 Quick Guide
The 64 Performances for the MM6 are
more suitable for live music than the more
pattern orientated factory Performances.

timode).
The demo songs combine MIDI and audio
tracks. The MIDI tracks control the MM6 /
MM8. The audio tracks are used to play
back samples from the included „WAV
pool”.
The free software package can be requested by sending an e-mail containing the
keyword „MM6 / MM8 Live & Studio“ to:
motifnews@easysounds.de

TENORI - ON :
Eur ope a n Voic e & S a m p l e b a n k
Yamaha Music Europe and EASY
SOUNDS
provide
their
free
soundlibrary „European Voice &
Samplebank“ to all Tenori-On
users.

• DR_AnalogKit2.tnw

audio sequencer. Then simply drag and

• VO_VocalsFemale.tnw

drop the samples you want to use into the

• DR_BreakKit.tnw

Voice Manager software.

The downloadable file (48 MB) contains the

• VO_VocoderFemale.tnw

following:

• DR_XdrumBasic.tnw

• 18 Tenori-On User Voices (Samplings)
• 4 Tenori-On Demos (AllBlock-Files)
• 268 Samples in WAV-Format (19 MB)
• Comprehensive PDF documentation

• VO_VocalsMale.tnw
• DR_XdrumAdd.tnw

• VO_VocoderMale.tnw
The samples used in the Voices are also
provided as WAV files. Hence you can use
the downloadable Tenori-On User Voice

This free sound library can be requested by
sending an e-mail containing the keyword
„Tenori-On European Voice & Samplebank“
to:
motifnews@easysounds.de
You will receive an e-mail from EASY
SOUNDS with a password and a link where
the file can be downloaded. The size of the

The User Voices feature multiple drum kits,

Manager to individually re-map the drum

sound effects, vocal / vocoder kits, and

and FX kits. This way you can modify the

synth sounds. Here‘s an overview of the

supplied kits or combine new ones from the

In addition you are automatically registe-

User Voices:

scratch.

red for the free monthly Music Production

• BA_MiniSquare.tnw
• FX_Atmo.tnw
• BA_Xbass.tnw
• FX_Long.tnw
• CO_CombKit1.tnw
• FX_Short.tnw
• CO_CombKit2.tnw

The User Voices „CO_CombKit1“ and

download file is 49 MB.

Guide.

„CO_CombKit2“ demonstrate how the
sounds can be combined in a creative way.
They use samples from different sample directories. Combining sounds really widens
the sound variety enormously.

• SQ_DarkUni.tnw

So if you want to set up your own kits from

• DR_AnalogKit1.tnw

the WAV files you first should audition the

• SQ_Xsynth.tnw

samples using a file player, sampler, or
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F re e D r u m k i t s
f or DT X 9 0 0 & D T X TREMEI I I
Yamaha offers free content for DTX900K, DTX950K, and DTXTREMEIII.
There are five content packages available for downloading:
• Extra Content 1 - Jazz Kit (4 Drum Kits)
• Extra Content 2 - Rock Kit (13 Drum Kits)
• Extra Content 3 - Electronic Kit (15 Drum Kits)
• Extra Content 4 - Vintage Kit (6 Drum Kits)
• Extra Content 5 - Oak Kit (6 Drum Kits)
Altogether there are 44 Drum Kits (containing 150 MB samples) available.
For more information and the download links visit:
http://dtxdrums.yamaha.com
Go to the Downloads / Driver and Software section.

Ocean Way Drums DTXPANSION Kit
These three Drum Kits have been produced by Yamaha‘s sound designer Dave Polich and are based on the sample library from Ocean Way
(Sonic Reality).
The Drum Kits feature a very complex programming containing multiple velocity layers. You can download the file at:
http://www.dtxperience.com/dtxpansion.php

F re e D r u m k i t s
f or th e D T X -MULT I 1 2
Yamaha provides 25 high quality Drum Kits (75 MB) for the DTX-MULTI 12 for free download.
It is the same content that has been available for some time now for DTX900K, DTX950K, and DTXTREMEIII.
Here‘s an overview of the available Kits, which are divided into two files:
File 1 = Acoustic Kits
• Jazz Maple (5 variations)
• Oak X Single (5 variations)
• Vintage (5 variations)
• Rock Single (5 variations)
File 2 = Electronic Kits
• ClasscDance
• Classic RX
• Drum’n’Bass
• HipHop90bpm
• House 128bpm   
More information and download links can be found here:
http://download.yamaha.com
First select your country and then enter DTX-MULTI12 into the search form.
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D T X - MULT I 1 2 So u n d s e t:
„Ori e n t a l P e r c u s s ion“
The DTX Electronic Percussion Pad MULTI-12 uses many of the high-end
features and sounds from the DTX and MOTIF series and provides an
optimum tool for live drumming, productions or rehearsals.
With over 1,200 high-class sounds - including newly-developed drum, percussion and keyboard sounds - the DTX-12 MULTI enriches any musical situation. Up to 200 User Sets can
be programmed and added with effects to get ready for every conceivable musical style with
the best sounds around. In addition, the large 64MB Flash-ROM Wave-Memory can be filled
with additional samples which then can be assigned to the Pads.
Now the brand new soundset „Oriental Percussion“ for the DTX-MULTI 12 is available for
registered users. It is provided by EASY SOUNDS on behalf of Yamaha Music Europe - free
of charge.
The download package includes the following:
• 50 Patterns
• 24 Kits
• 132 User Waves (18 MB Samples)
The soundset has been designed primarily for traditional and modern Turkish music.
It‘s based on authentic samples of oriental percussion instruments.
The oriental instruments are however well suited for use in other music styles such as Pop,
World, Chill Out, Ambient, etc.
„Oriental Percussion“ was programmed by the Turkish musician and producer Mert Topel.
Since 1990 Mert Topel is working as a musician with nationally and internationally known
pop and rock stars such as Tarkan (1993-2008) and many others. Mert recorded several albums as a producer of jazz, fusion, rock bands, and singers like Kirac, Mor ve Otesi, Gülden
Goksen, Grizu etc. He also has his own jazz-rock band „Fenomen“, which published its first
album in 2006 - with very good response from jazz lovers. Right now his band is working
on a second album. Another project is a collaboration with Alper Maral in the production
of an electro-acoustic-oriented album called „The Voltage Control Project“, which appears
in 2010.
The DTX-12 MULTI Patterns produced by Mert Topel should inspire the musician in the first
place and serve as basis for his own music productions.
This free soundset can be requested by sending an e-mail containing the keyword „DTX-M12
Oriental“ to:
motifnews@easysounds.de
The user will receive an e-mail from EASY SOUNDS with a password and a link where the
file can be downloaded. The size of the download file is 24 MB.
In addition you are automatically registered for the free monthly Music Production Guide.
Alternatively the Soundpackage can be delivered on an USB memory stick, which must be
ordered for a reasonable price from www.easysounds.de in addition to the e-mail procedure
mentioned above. Remember to add the keyword „DTX-M12 Oriental“ to your USB memory
stick order.
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F re e T u t o r i a l D V D
f or MO T IF X S / X F U s e r s
The free tutorial DVD „The World of MOTIF XS“ (English language) is available for all registered european MOTIF XS and MOTIF XF users.
The DVD procures comprehensive instructions on how to use a MOTIF XS in a music production environment. The running time of over 3 hours covers deep insights in topics like interactive Arpeggios, live performances, sampling, recording sessions, Cubase AI and much more.
Although the instructions refer to the MOTIF XS, this DVD is of interest for MOTIF XF users,
because the XS‘ operation is substantially the same concept.
To request this DVD simply write an e-mail to:
musicproduction@yamaha.de
Please give your name, address, serial number of your MOTIF XS or MOTIF XF, and the keyword „The World of MOTIF XS“ - even if you already are a registered MOTIF XS user.
Important note: This DVD can not be shipped outside Europe!

C ubas e A I T ut o r i a l Vid e o s
f or r egi s t er ed u s e r s
Thanks to the cooperation between Yamaha and Steinberg most of
the recent instruments and mixing desks from the Yamaha Music
Production range have the DAW software Cubase AI included – for
those who do not own a DAW software yet this is one good reason
more to buy from Yamaha. Even more Cubase AI is a music production tool with functions which were exclusive for high-end studios not
very long time ago.
Even better: European customers buying a Yamaha Music Production
instrument with included Cubase AI software are qualified to request
a free English language tutorial CD from ASK Video containing 23
videos on how to use Cubase AI4.
The CD is English language only and only available as long stocks
last. So better be quick – request your CD by sending an e-mail
containing the serial number of your Yamaha instrument and your
name and address to:
musicproduction@yamaha.de
MOTIF XS users can order this CD in combination with the tutorial DVD „The World
of MOTIF XS“.
Important note: This CD-ROM can not be shipped outside Europe!
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O ption a l s o un d s e t s f o r
MOTI F- S er i es / S - S e r i e s / M O
„ Xtasyn“

„Hypnotic Stepz“

Up-to-date synth and drum sounds for dance,
trance, pop, and electronic. Phat leads &
synthcomps, pads, FX. Special attack Waveforms for punchy sounds

For users having a penchant for stepsequencers and analogue synth sounds. Synth
sounds, drums and sequences are impres
sively combined

„FM Xpanded – Vol . 1:
Electric Piano & Clavinet“

„Magical Pads“

Sample-based FM sounds with very high dynamic and authenticity, which are heavily
based on classic DX7 sounds, but also offer
new and innovative creations

Provides warm, analogue pad sounds with
huge atmosphere. Refined with sweeps,
swells, synthbrasses, atmo-sounds, and musical sound effects

„Phat Analog“

„Mystic Spheres“

Synthleads,
pads
&
more!
Time
less Voice and sample library with a
Minimoog emulation (Leadsynths) and JP-8
sounds. The ultimate analogue extension!

The ultimate Ambient + Electronic set. It contains atmospheres, pads, sound effects, spacy
synth leads, trance sounds, vocal pads, and
analogue vintage sounds

„Chill Xperience“

„Vocoder Dreamz“

Soundset for Chill Out, Lounge, Ambient,
New Age, Electronic, and related genres.
These sounds offer a high level of musical
inspiration

Combines vocoder Voices, vocal phrase kits,
and drum loop kits. The vocal phrases and
drum loops are controlled by User Arpeggios.
Its speciality is the vocoder choirs

„Drum Performer“

„Organ Session“

Lavishly produced ‘Real Drums’ for extremely
realistic sound; dry, fat and punchy. Extreme
range of sounds achieved by different recording techniques

This set is an impressive emulation of the
legendary Hammond B3. Smacky organ
sounds with concise key click and controllable
percussion. Perfect for Rock, Pop and Jazz

„Stage & Studio“
The ultimate top 40 and live set! Contains
the most important standard instruments and
synth sounds for live musicians. Outstanding
performance and power

General Information:
The above sound sets are available for the following devices:
• MOTIF XF, MOTIF XS, MOTIF ES, MOTIF-RACK XS,
		 MOTIF-RACK ES, S90 XS, S70 XS, S90 ES, MO6, MO8

„Dance Xpanded“
Sounds for Dance, Trance, Electronic, Chill
Out, Pop. The Voices include atmospheres,
pads, leads, synth basses, chord synths, gated
pads, and arpsounds

• The sound sets ‘FM Xpanded’, Drum Performer and
		 ‘Vocoder Dreamz’ are available exclusively for MOTIF XS
		 and MOTIF XF
Each sound set contains 128 Voices. Depending on the device,
additional content such as Performances, Samples, User Arpeggios, and WAV Loops are included. Further details can be found on
www.easysounds.de

„Synth Xtreme“

Price per soundset= 35,- EUR

Offers a vast range of fat, analogue synth
sounds of the highest quality. Suitable for
Trance, Electronic, Techno, and many other
genres of trendy pop music

The soundsets are available from:
EASY SOUNDS – Peter Krischker
vertrieb@easysounds.de
http://www.easysounds.de
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Impr int & fu r t h e r Lin k s

Important websites
for MOTIF users
Official international Yamaha website for synthesizers
including a comprehensive download section
http://www.yamahasynth.com/

Yamaha
Music Productio n Guide
The official News Guide about the Yamaha Music Production product series and Computer Music Instruments
Published by

Official website of Yamaha Music Europe GmbH

EASY SOUNDS

http://www.yamaha-europe.com

Peter Krischker

American MOTIF support website including message

Am Langberg 97 A

board + KEYFAX webshop + „XSpand Your World“
downloads
http://www.motifator.com/
EASY SOUNDS website + webshop sounds and
USB sticks for Yamaha synths
http://www.easysounds.de
John Melas MOTIF Site
Editor softwares for the MOTIF series
http://www.jmelas.gr/motif/

D-21033 Hamburg
Telephone: +49 40 - 738 62 23
in cooperation with
Yamaha Music Europe GmbH
Siemensstraße 43
D-25462 Rellingen
Telephone: +49 41 01 - 30 30
e-mail: motifnews@easysounds.de
The free Music Production Guide is published monthly and
contains news, tips & tricks, software offers, and interviews
on and around Yamaha synthesizers of the MOTIF series,

Music Productio n Guide
History
You can download all English editions already pub-

S series, MO series, MM series, Tenori-On, and articles
about recording, software, and Computer Music Instruments.

lished as one single ZIP file using this link to the EASY

You can subscribe or unsubscribe to the free Music Produc-

SOUNDS website:

tion Guide by sending an informal e-mail to:

http://www.easysounds.eu/NewsGuides_E.zip
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